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INSTRUCTIONS TO THE CANDIDATES

This exam is of 120 minutes duration and the Test Booklet cum answer sheet contains 68 questions.

All questions are compulsory.

These 68 questions are divided into four sections (A, B, C and D) as per the details given below:

i.  Section A consists of 50 (fifty) multiple-choice questions (four options with a single correct
answer) (Question no. — 01 to 50). For each correct answer, the candidate will get 1 mark. No
negative marking.

ii. Section B consists of 10 (Ten) questions (Question no. — 51 to 60): Very Short Answer Type
Questions (Answer in one word/one sentence) = 10 Questions (2 marks each)

iii. Section C consists of 05 (five) questions (Question no. — 61 to 65) Short Answer Type
Questions (Answer within 50 words) (3 marks each)

iv. Section D consists of 03 (Three) questions (Question no. — 66 to 68) Descriptive Answer Type
Questions (Answer within 100 words) (5 marks each)

Maximum marks are 100.

Use a Blue/Black ballpoint Pen (as provided by the Centre) only for writing particulars on this
page/marking answers on the Test Booklet cum Answer Sheet.

Rough work is to be done in the space provided for this purpose in the Test Booklet only. No
additional sheets would be provided.

On completion of the exam, the candidate must hand over the Test Booklet cum Answer Sheet to
the Invigilator before leaving the room/hall.

The candidates should ensure that the Test Booklet cum Answer Sheet is not folded. Do not make
any stray marks on it. Do not write your Roll No. anywhere else except in the specified space in
the Test Booklet cum Answer Sheet. The use of white fluid for correction is NOT permissible on
it.

Each candidate must show on-demand his/her Admit Card to the Invigilator.

No candidate, without special permission of the Centre Superintendent or Invigilator, would leave
his/her seat.

Use of an Electronic/Manual Calculator or Smart watch or any other electronic gadget is strongly
prohibited.

The candidates are governed by all Rules and Regulations of the examination with regard to their
conduct in the Examination Room/Hall. All cases of unfair means will be dealt with as per Rules
and Regulations of this examination.

No part of the Test Booklet cum Answer Sheet shall be detached under any circumstances.

The candidates will write the Correct Test Booklet Number and Code as given in the Test Booklet
cum Answer Sheet in the Attendance Sheet.



[ Section - A ]

Note: Attempt all MCQ type questions, each question carries 1 mark.

1. Which of the following sentences is grammatically correct?

(a) The company is running successfully since ten years.

(b) The company has been running successfully since ten years.

(c) The company is running successful since ten years.

(d) The company has been running successfully for ten years

2. Choose the word closest in meaning to the word Insistence, from among the

options:
(a) Relying (b) Urging
(c) Lying (d) Recognizing

3. Fill in the blanks with appropriate, word chosen from the given alternatives “The
youth should believe God”.

(a) upon (b) on

(c) of (d) in

4. Fill in the blanks with appropriate, word chosen from the given alternatives “The

ship was attacked by near a deserted island”.
(a) Burglars (b) pirates
(c) Thieves (d) Gangsters

5 The number of heart beats on an average in an adult human is in the range of

(a) 60-65 (b) 66-70

(c) 71-80 (d) 85-90
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i by :-
Accounts of the Union Government shall be certified by
(a) Controller General of Accounts (CGA)

(b) C & AG (Comptroller and Auditor General of India)
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s - ent
(c) Financial advisor of the concerned Ministry/ Departmen

(d) Public accounts committee

A post carrying definite rate of pay sanctioned for a limited time 1s a :-

(a) Temporary post (b) Supernumerary post

(¢) permanent post (d) Ex cadre post

The ‘Run for Unity’ event is organized in India to mark the birth anniversary of
which freedom fighter?

(a) Lal Bahadur Shastri

(b) Mahatma Gandhi

(c) Sardar Vallabhbhai Patel

(d) Subhas Chandra Bose

Sonal and Manav started working on a project and they can complete the project in
30 days. Sonal worked for 16 days and Manav completed the remaining work in 44
days. How many days Manav would have taken to complete the entire project all
by himself?

(a) 60 (b) 20 (c) 46 (d) 55

A tank can be filled by two pipes A and B in 20 hours and 30 hours respectively.

Pipe B is opened after 5 hours of pipe A being opened. How long will it take to fill
the tank?

(a) 15 hours (b) 20 hours

(c) 18 hours (d) 25 hour
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. A rnan- spends 60% of his income. If his income increases by 15% and his
expenditure by 15%. Find the percentage change in his saving.

(@) 15% (b) 10% (c) 5% (d) 12%

In a certain code language, 'CAT' is written as 'XZG'. How is 'DOG' written in that
code?

(a) WTL (b) WLT

Complete the series: 2, 6, 12,20, .

(a) 28 (b) 30 (c) 32 (d) 36

Five friends A, B, C, D, and E are sitting in a row facing north. D is to the immediate
right of A and C is to the immediate right of D. B is to the immediate left of A.
Who is sitting in the middle?

(@A () D (c)C (d)B
The Tripura University Established on

(2) 12 October, 1987 (b) 2 October, 1987

(c) 2 October, 1988 (d) 12 October, 1987

Department of Higher Education recently signed an MoU with which organization
for creating the Digital Library Platform, Rashtriya e-Pustakalaya?

(a) Central Board of Secondary Education

(b) National Book Trust

(c) National Library Association

(d) Ministry of Culture
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. 1o TR otatement?
In Excel, what is the function of the "IF" sta

d another
(a) Performs a logical test and returns one value for TRUE an :|

for FALSE j
(b) Calculates the sum of a range
(¢) Counts the number of cells with numbers N

(d) Sorts data in ascending order

Which programming language is most commonly used for Al and machine learning

applications?
(a) Java (b) C++
(c) Python (d) JavaScript

How can you protect a worksheet so that users cannot change the values in certain
cells?

(a) Data > Data Validation (b) Review > Protect Sheet

(c) View > Freeze Panes (d) Home > Format Cells

In Excel, what does the VLOOKUP function do?

(a) Looks up a value in a table based on a vertical match

(b) Calculates the vertical sum of a range

(c) Returns the vertical position of a value

(d) Searches for a value horizontally

What does the Excel function =SUMIF(A1,">5") do?

(a) Sums all values in the range A1 to A10

(b) Sums all values in the range A1 to A10 that are greater than 5

(c) Counts the number of cells in the range Al to A10 that are greater than 5

(d) Averages the values in the range Al to A10 that are greater than 5
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Which an?ong the following articles of Constitution of India abolishes the
untouchability?

(a) Article 17 (b) Article 18

(c) Article 15

(d) Article 16

. The Fundamental Duties are mentioned in

(a) Part-IV A (b) Part-IV

(c) Part-III (d) In schedule IV-A

Which of the following Article of the Indian Constitution contains Fundamental
Duties?

(@45 A (b) 51 A

(c) 42 (d) 30B

As per RTI Act 2005, each institute has to take suo moto disclosure action to
provide as much information to the public at regular intervals through various
means of communication including internet

(2) Under Section 4 of RTTI act 2005

(b) Under Section 3 of RTI act 2005

(c) Under Section 5 of RTI act 2005

(d) Under Section 6 of RTI act 2005

The government servant shall be deemed to have been placed under suspension, if,
in the event of a conviction for an offence is sentenced to him a term of

imprisonment exceeding ?
(a) 24 hours (b) 48 hours
(c) 72 hours (d) Less than 6 hours




27. Ministry of finance has implement
department. The PFMS system the E
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43,

(a) Expenditure, advance, transfer

ed the PFMS system to use in governmep;

(b) Expenditure, accounting, tracking

(c) Expenditure, analysis, tracing

(d) Execute, Analyze and Trace

Complete the series: 3, 7, 23, 95, ?

(a) 62

Volume of a cylinder with base radius =r and height = h, is:

(a) 2nrh

(c) 2nr (r + h)

cuboid has

(a) 2

What is the solution of the system of equations 2x -y =1 and x + y = 5?

(a)x=2,y=3

()x=1,y=4

(b) 479

(c) 225

(b) mr*h
(d) 1/3 mr*h

pairs of identical faces.

(b) 3

(c) 4

(b)x=3,y=2
@x=4,y=1

AT module. The term “EAT” means

(d) 575

d>s

L) L)L

The mean of 50 numbers is 40. If two numbers, 25 and 35, are discarded. then the

mean of the remaining numbers is:

(a) 39

(b) 40

(c) 41

(d) 42

Who became the new Prime Minister of the United Kingdom in 20242

(a) Boris Johnson

(a) Rishi Sunak

(a) Liz Truss

(a) Keir Stanner




34. Which country became the first in the world to legally recognize 'climate refugees'

in 2024?
(a) Sweden (b) New Zealand
(c) Canada (d) Fiji
35. Which technology company announced the launch of its own Al model, similar to
Open Al's GPT models, in 2024?
(a) Google (b) Microsoft
(c) Apple (d) Meta
36. In 2024, the United Nations commemorated the 75th anniversary of which
significant event?
(a) The founding of the UN
(b) The Universal Declaration of Human Rights
(c)The end of World War I1
(d) The first manned moon landing
37. Which country recently became the first to host both a Summer and Winter
Olympics in consecutive years?
(a) South Korea (b) Japan
(c) China (d) France
38. In 2024, which nation became the first in Africa to officially legalize same-sex

marriage?

(a) South Africa

(b) Kenya

(c) Uganda

(d) Botswana
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D.F.A means

(a) Demand from administration
(b) Draft for approval

(c) Draft for admission

(d) None of these

Systematic arranging and preserving records is called

(a) Collection (b) Filing

(¢) Indexing (d) Covering

When some information is to be circulated amongst all employees in an

office, a_is issued.

(a) Office agenda (b) Circular

(c) Press note (d) Memo

Which of the following is a key responsibility of a personal secretary?
(a) Preparing financial statements

(b) Managing the calendar and appointments of the boss

(c) Handling legal contracts

(d) Developing marketing strategies

What is the primary purpose of a memo in an office setting?

(a) To provide financial data

(b) To communicate brief information or instructions within the
organization

(c) To schedule meetings

(d) To offer personal notes to employees
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44. Which of the following

letter? 18 the most appropriate way to address a superior in a formal

(a) Dear [First Name]

(b) Dear [Mr./Ms./Dr. Last Name]

(c) Hi [First Name]

(d) To whom it may concern

45. Which of the following is an important skill for a personal secretary to have?

(a) Programming skills

(b) Multitasking and time management

(c) Knowledge of accounting

(d) Design and multimedia skills

46. In which situation would you most likely use the “Bcc” (blind carbon copy) feature
in an email?

(a)To send an email to multiple recipients without them seeing each
other’s addresses

(b) To ensure the recipients can reply to everyone

(c) To mark the email as high priority

(d) To keep the subject of the email hidden

47. What is the SI unit of force?

(a) Joule

(b) Newton

(c) Watt

(d) Pascal

11
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The process of conversion of glucose into energy in the body is known as:

(a) Photosynthesis b |

(b) Respiration

(c) Fermentation

(d) Digestion

Which of the following is an example of a biodegradable substance?

(a) Plastic (b) Glass

(c) Paper (d) Aluminium

Which of the following is a non-renewable source of energy?

(a) Solar energy

(b) Wind energy

(c)Coal

(d) Geothermal energy

TOTAL NUMBER OF MCQs ATTEMPTED

12
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